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Using RED Media with 
Final Cut Studio 
 

This document describes the best practices for following a digital cinema postproduction 
workflow with Final Cut Studio using media recorded with the RED camera. 

Minimum processor requirements for using the RED plugin with Final Cut Studio: 
• Dual 2.0 GHz or faster Intel Core Duo, or Intel Xeon processor (the RED plugin is only 

compatible with Intel processors), with a minimum of 2 GB of RAM 
 

Minimum software requirements for using the RED plugin with Final Cut Studio: 
• Mac OS X v10.4.11 or Mac OS X v10.5.5 or later 
• QuickTime 7.5.5 or later 
• Final Cut Pro 6.0.5, Color 1.0.3, and Compressor 3.0.5 
• The RED Final Cut Studio Installer (version 1.0) 

(available at http://www.red.com/) 

Shooting RED Media to Use With Final Cut Studio 
Final Cut Pro and Color have been tested with a specific subset of the resolutions and 
frame rates supported by the RED camera that are intended for digital cinema 
production. This section outlines how to choose a resolution, timebase, and timecode 
track to use with Final Cut Pro and Color. 

Choosing a Resolution to Use with Final Cut Studio 
When picking a resolution to shoot with, you should keep in mind that although the RED 
camera can shoot media at 4K, 3K, and 2K resolution, there are plusses and minuses to 
each resolution if you’re planning on doing your postproduction using Final Cut Studio: 

• 4K media is always resized to 2K during the Log and Transfer process. 
• 3K media is not resized during ingest, but this resolution is not supported by Final Cut 

Pro’s realtime effects architecture, so it may be an inconvenient format with which to 
edit. Furthermore, although Color can read 3K media, it will resize it by half when 
rendering, resulting in 1.5K media. 

• 2K media is imported as is, with no resizing. 
 

Since only 2K resolution is supported by Final Cut Pro’s realtime effects architecture, 
and 2K is the maximum resolution that can be output by Color, you might think that 
shooting 2K is the easiest way to go. While 2K is well suited for slow motion 
cinematography, RED does not recommend 2K as a primary shooting mode for principal 
photography.  
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Keep in mind that the RED camera records smaller resolutions by using less of the 
sensor’s area. If your goal is to shoot with a shallow depth of field, this may not be ideal. 
Depending on the combination of lens and exposure you’re using, you may find it 
preferable to shoot 4K in the field (thus exposing the greatest possible area of the 
sensor, comparable to a Super 35MM film gate) in order to obtain the shallowest depth 
of field for your compositional needs, and let Final Cut Pro downconvert to 2K during 
Log and Transfer. It’s also worth noting that shooting 4K will result in higher image 
quality even after the eventual downconversion in Final Cut Pro.  

Choosing an Aspect Ratio 
The RED camera supports two variants of each resolution, a 2:1 aspect ratio for 
projects intended for film output, and a 16:9 aspect ratio for projects intended for video. 
Color has only been tested with the 2:1 variant of the 2K resolution. Whether you shoot 
4K @ 2:1 and downconvert during Log and Transfer, or simply shoot 2K @ 2:1, your 
working resolution in Final Cut Pro and Color will be 2048 x 1024, which is suitable for 
projects being printed to film. Although the 2:1 aspect ratio is a bit wider than the 1.85:1 
standard, you can easily crop a bit off the sides in preparation for printing to film. 

Important — The 2048 x 1152 resolution that corresponds to a 16:9 aspect ratio has 
not been tested with Color. If you plan on using this resolution, you should do your own 
workflow tests before committing to shooting your project at this resolution. 

Choosing a Frame Rate to Use with Final Cut Studio 
The Color workflows in this document have only been tested with timebases of 23.98 
and 24. Although the RED camera supports shooting other frame rates such as 25, 
29.97, 50, and 59.94 that are appropriate for broadcast, you should perform your own 
workflow tests with Final Cut Pro and Color before you commit to shooting an entire 
project with one of them. 

Choosing the Appropriate Timecode Track for Each Magazine You 
Record To 
Every frame rate for RED media is recorded as progressive frame, so the timecode 
recorded by the RED camera is always non-drop. The timecode that is recorded for 
each clip depends on what the RED camera’s Display menu is set to when the clips are 
recorded. There are two choices in the RED camera’s Display menu: 

• Time Code — This is the default, which is set to record timecode matching the 
camera’s “time of day.” However, if an external timecode source is connected to the 
camera’s SMPTE timecode input and the camera is put into Jam Sync mode, the 
external timecode will be recorded to each clip instead. In either case, the timecode of 
subsequently recorded clips will likely be discontinuous.  

• Edge Code — If this option is selected, the first clip recorded onto a blank magazine 
starts at 01:00:00:00, and the timecode of each subsequent clip is recorded 
sequentially and continuously as more and more clips are recorded. 
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Important —You should never change timecode tracks in the middle of a magazine. If 
you find it necessary to change the type of timecode you’re recording, make sure you 
only change the display timecode when you change magazines. 

In offline/online workflows, the reel name, clip ID, and timecode of transcoded 
QuickTime files are matched with the enclosing folder name, file name, and timecode of 
their R3D counterparts. 

Archiving RED Media in Preparation for 
Final Cut Pro Ingest 
No matter what your workflow is, it’s highly recommended that you archive all of the 
original RED media for your project onto one or more backed-up volumes, even if you’re 
planning on transcoding the media to another format. This ensures that you always 
have the option to retransfer RED QuickTime clips from the original R3D media. It also 
makes it easier to use the Log and Transfer window in Final Cut Pro to ingest media for 
your project. 

Regardless of whether you’re shooting with CF cards or a RED Drive, you should 
always copy the entire contents of each CF card or drive that you’ve finished recording 
with to an individually named folder on your archive volume. For example, if you’ve shot 
a project using 12 CF cards, the contents of each card should be copied into separate 
directories. At the end of the process you should have 12 different directories (perhaps 
named “MyGreatProject_01” through “MyGreatProject_12”), each of which contains the 
entire contents of the CF card to which it corresponds. 

 

Example of four archived directories of RED media. Each folder that contains a group of RED 
media folders, such as the Mag 1 through Mag 4 folders shown here, is treated as a reel by the 
Log and Transfer window. 

If you’re using a RED Drive, you should copy the entire contents of the drive to a new 
folder every time you fill it up or are finished with a particular part of your shoot. For 
example, if you’re archiving the contents of the drive after every day’s shoot, then after 
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four days you should have four directories (perhaps named “MyGreatProject _Day01” 
through “MyGreatProject_Day04”). 

Use sensible folder names, as the name of each enclosing directory is used by the Log 
and Transfer process to determine the reel name for each clip that’s ingested by Final 
Cut Pro. Furthermore, after you copy the media from each CF card or drive, do not 
under any circumstances change the directory names, file names, or otherwise modify 
the files that you’ve copied. Doing so may jeopardize your ability to later reconform 
offline sequences to the original source media. 

For safety, most productions immediately copy the contents of each CF card or RED 
drive to two separate volumes once recording on that magazine has finished. 

Tip — If you’re shooting using relatively inexpensive CompactFlash (CF) media, you 
should consider purchasing enough CF cards to shoot your entire project without having 
to erase and reuse cards. This provides you with valuable redundancy should your hard 
drive archival volumes later prove to have problems. At the very least, have enough CF 
cards for an entire day’s worth of shooting so you can verify the integrity of your media 
at the end of each day, before reusing them the next day. In either case, be sure to 
physically label each CF card with the name of the corresponding directory you copy its 
media to, as this is the only way you’ll later be able to match a directory of archived 
media to the CF card it was originally copied from. 

Archiving RED Media Using Disk Images 
For additional protection, consider copying the contents of each CF card or RED Drive 
into a disk image that’s sized appropriately for the contents using Disk Utility. You can 
use the Disk Image from Folder command to copy the entire contents of a mounted 
volume into a disk image.  

Archiving each “reel” of RED media using disk images provides checksum verification 
when the media is initially copied, as well as every time the disk image is mounted, 
which lets you immediately discover data errors should they occur. It also gives you the 
option of creating read-only archives, preventing unwanted manipulation of the source 
media later on.  

To archive RED media volume using a disk image: 
1. Mount the CF card or RED Drive you’re archiving. 
2. Open Disk Utility. 
3. Select the CF card or RED Drive from the list of drives at the left of the Disk Utility 

window. 
4. Choose File > New > Disk Image from “volume name,” where “volume name” is the 

name of the CF card or drive you selected. 
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5. Enter a unique name for the Disk Image in the New Image from Folder dialog, 
choose read only from the Image Format pop-up menu, and leave the Encryption 
pop-up menu set to none. 

6. Choose the volume to which you want to save the disk image, and click Save. 
 

After archiving reels of RED media into separate disk images, you’ll need to mount each  
disk image you want to Log and Transfer from. 

Note — You can also initiate this process from directly within the Log and Transfer 
window, although the resulting archives are always the size of the media volume you’re 
archiving, regardless of how full that volume actually is. For more information, see the 
“Archiving File-Based Media from Cards” section of the HD and Broadcast Formats 
document, available in the Help menu of Final Cut Pro. 

The Structure of RED Media Directories 
The RED media recorded to a CF card or RED Drive consists of a .RDM folder that 
contains a series of .RDC folders (Red Digital Clip). There’s one .RDC folder for each 
clip that was recorded. Alongside the .RDM folder are a few other files, .log and .profile 
files that contain camera data that, while not used by the workflows described in this 
document, should be retained. When archiving RED media, you should always copy the 
entire directory structure of every volume you record to.  

For your reference, each .RDC folder contains the following media files: 

• .R3D — This is the high-quality REDcode raw image data itself. Since there’s a 2 GB 
limitation on file sizes, longer clips may consist of multiple “spanned” R3D files. In this 
case, every file must be present for the clip to be readable. R3D filenames with suffix 
numbers (such as _001) should never be altered, as this will make them unreadable 
by the Log and Transfer window. 

• .mov — Four QuickTime reference movie files serve as proxy files for applications 
that support this file structure. These movies are not used by the Final Cut Studio 
workflows described in this document. QuickTime proxy creation is optional, and can 
be turned off by toggling the QT Proxies checkbox in the Project settings of the 
camera. 
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Example of a single RED media directory, containing .log and .profile files, as well as the .RDM 
folder which contains the actual .RDC folders that contain the recorded media. The media 
stored in each .RDM file consists of one R3D file and four optional .mov files. When archiving 
RED media, you must keep the entire directory structure intact.
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Ingesting RED Media with Final Cut Pro 
The Log and Transfer window in Final Cut Pro is the preferred method of ingesting RED 
media into Final Cut Pro. When using the Log and Transfer window, the R3D media 
recorded by the RED camera is converted to QuickTime media using one of two 
methods. 

Method 1: Transcoding to ProRes 422 
You may choose to transcode R3D media to ProRes 422 or ProRes 422 (HQ) 
compressed QuickTime files. ProRes 422 is suitable for creating lower-quality files for 
offline editing, but ProRes 422 (HQ) is recommended for higher-quality mastering. You 
can set this up by opening the Log and Transfer window’s Import Preferences dialog. 

To transcode RED media to ProRes 422 or ProRes 422 (HQ) clips: 
1. Mount the volumes that contain your archived RED media. 
2. Open the Log and Transfer window, and choose Preferences from the Action pop-up 

menu (the menu with the gear icon).  
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3. When the Import Preferences sheet appears, choose either Apple ProRes 422 or 
Apple ProRes 422 (HQ) from the “Transcode to” column corresponding to the RED 

Digital Cinema REDCODE item of the list. 
 

4. Optionally, you can choose a color option from the RED FCP Log and Transfer 
plugin submenu of the Action pop-up menu. By default, this is set to Native, but you 
can choose any other option from this submenu with which to preprocess the 
ingested clips. More information about this option appears below. 

5. To proceed with ingesting RED media, follow the instructions in the “Using the Log 
and Transfer Window” section of the “Working with High Definition and Broadcast 
Formats” documentation, found in the Final Cut Pro Help menu. 
 

The Color, Color Temp, and View RED camera settings in use while shooting are stored 
as metadata within each recorded R3D file. When you transcode R3D media to ProRes 
422, this metadata is used to preprocess the color and contrast of the transcoded media 
as long as the “RED FCP Log and Transfer plugin” submenu of the action menu is set to 
Native, which is the default setting. The result is that each transcoded clip visually 
matches the image that was monitored during the shoot. This preprocessing is “baked” 
into each ingested clip. If you want to later reapply a different type of image 
preprocessing to a clip, you need to reingest it. 

If necessary, you can choose other color processing options from the RED FCP Log 
and Transfer plugin submenu of the Action pop-up menu.  
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The image preprocessing options found in the RED FCP Log and Transfer plugin submenu 

By default, there are five options: 

• Native — The Default. Uses each clip’s internal metadata to preprocess the clip. The 
result should look nearly identical to the image as it was monitored during the shoot. 

• Tungsten — Preprocesses each clip with a color temperature correction that 
assumes warmer (more orange) Tungsten lighting, to achieve a neutral result. 

• Daylight — Preprocesses each clip with a color temperature correction that assumes 
cooler (more blue) Daylight lighting, to achieve a neutral result. 

• Warm – An adjustment that attempts to preprocess the image so that the final result is 
warmer (more orange) than the originally monitored image. 

• Sepia – An aggressive adjustment that preprocesses the image with a sepia-tone 
result. 

 

Important — The color preprocessing option you choose is applied to every clip shown 
in the browser area of the Log and Transfer window. As you place a selected clip into 
the ingest queue the current color processing options are applied. Changing the color 
preprocessing option will not affect clips currently in the ingest queue. 

Optionally, you can export your own color processing preset from RED ALERT!, and use 
it to preprocess transferred clips in different ways. RED ALERT! is available for free 
from the support page at http://www.red.com/. 
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To export image-processing presets from RED ALERT! to use in Final Cut Pro: 
1. Open RED ALERT!, and choose File > Open R3D to open a REDcode media file to 

use to create your preset. 
2. Use the controls at the left of the RED ALERT! window to adjust the image in order 

to create the look you want. 
3. When you’re finished, choose File > Save Preset. 
4. Open the following directory to save the .rlx file into: 

/Library/Application Support/REDAlert/Presets 
5. Click Save. 

 
The next time you open Final Cut Pro, you’ll be able to choose your custom image 
processing preference from the Action pop-up menu of the Log and Transfer window. 

Note – The Curves, Gamma Space, Color Space, OLPF Compensation, and Denoise 
settings in RED ALERT! are ignored when exporting image-processing presets. 

Method 2: Ingesting RED QuickTime Files 
You may instead choose to ingest the R3D media as RED QuickTime files. When you 
do so, you’re actually wrapping the original R3D data within a QuickTime wrapper. The 
resulting media file appears as any other QuickTime file in the Finder, but provides 
direct access to the original RAW camera data for specifically compatible applications. 
This provides the highest quality, and is faster than transcoding to ProRes 422, but the 
resulting media is more processor-intensive to work with. 

To ingest RED media as RED QuickTime files: 
1. Mount the volumes that contain your archived RED media. 
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2. Open the Log and Transfer window, and choose Preferences from the Action pop-up 
menu (the menu with the gear icon). 
 

 
3. When the Import Preferences sheet appears, choose Native from the “Transcode to” 

column corresponding to the RED Digital Cinema REDCODE item of the list. 
 

4. To proceed with ingesting your RED media, follow the instructions in the “Using the 
Log and Transfer Window” section of the “Working with High Definition and 
Broadcast Formats” documentation, found in the Final Cut Pro Help menu. 
 

Tracking Ingested Media to the Original R3D Media 
Whether you choose to transcode or ingest RED media, the correspondence between 
the source R3D media and the QuickTime files that are created during the Log and 
Transfer process is maintained in three ways: 

• The name of the top level directory that encloses each set of archived RED media is 
used as the reel name of ingested clips. 

• The name of each R3D file is used to create the universally unique ID number (UUID) 
which is also referred to as the Clip ID for each ingested clip. This ID number, which is 
not user-accessible, is used to track the correspondence between ingested clips and 
the original source media from which it came. This means you can rename clips as 
you ingest them, or afterward, without losing the correspondence between a clip’s 
UUID tag and the name of the original R3D file. 

• Each ingested clip’s non-drop frame timecode matches that of its corresponding 
archived R3D file. 
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Specifications for RED QuickTime Media 
Once ingested, RED QuickTime files have the following characteristics: 

• Color space — RGB 
• Chroma subsampling — 4:4:4 
• Bit Depth — 12-bit 
• Supported resolution — 2048 x 1024 (2:1 aspect ratio) 
• Pixel aspect ratio — Square 
• Field dominance — None 
• Supported progressive frame rates— 23.98, 24 
• Timecode — Non-drop 

 
Which Applications Are Compatible with RED QuickTime Media? 
RED QuickTime files are read-only compatible with Final Cut Pro, Color, and 
Compressor. These applications can import RED QuickTime files for use in a project, 
but can neither render nor export clips using the REDCode compressor. 
 
RED QuickTime files have not been tested extensively with Motion, LiveType, or Shake. 
If you want to send RED QuickTime files to any of these applications, you should 
perform workflow tests first. If in doubt, you can always transcode the media you need 
to work on using another codec such as ProRes 422 or Uncompressed. 

Using RED QuickTime Media in Final Cut Pro 
This section covers important information about using RED QuickTime media in a Final 
Cut Pro project. 

Creating a “RED Using ProRes” Sequence Preset in Final Cut Pro 
If you plan to edit RED QuickTime files in Final Cut Pro, it’s best to create a sequence 
preset that’s designed to accommodate RED QuickTime media. Because RED 
QuickTime media is read-only, you need to make sure the Codec pop-up menu in the 
General tab of the Sequence Settings window is set to either ProRes 422 or ProRes 422 
(HQ) in order to properly render and play back effects such as transitions, filters, and 
motion settings.  

To create a sequence preset for RED QuickTime media: 
1. Choose Final Cut Pro > Audio/Video Settings. 
2. Open the Sequence Presets tab, select one of the Presets in the list (the Apple 

ProRes 422 1920x1080 24p 48 kHz preset is a good one to start with), and click 
Duplicate to make a copy. 

3. When the Sequence Preset Editor appears, enter a new name (such as “RED Using 
ProRes”) and description in the top two fields. 

4. Adjust the settings of the General tab in the following order: 
• Aspect Ratio pop-up menu – Custom 
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• Frame Size – 2048 x 1024 
• Field Dominance – None 
• Editing Timebase – 23.98 or 24 
• Timecode Rate – Same As Editing Timebase 
• Compressor – Apple ProRes 422 (HQ) 
• Rate – 48 kHz 
• Depth – 16-bit 
• Config – Channel Grouped 
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5. For maximum image quality when rendering the final output of your program, click 
the Advanced button in the QuickTime Video Settings area to open the Compression 
Settings window, in order to access the Enable 4:4:4 chroma filtering option. 
 

 
 

6. When the Compression Settings window appears, turn on Enable 4:4:4 chroma 
filtering and click OK. Since RED media uses 4:4:4 chroma subsampling, this option 
will result in a higher quality conversion to the 4:2:2 chroma subsampling employed 
by ProRes 422. 
 

 
 

7. Lastly, open the Video Processing tab, and select “Render 10-bit material in high-
precision YUV.” This is the highest quality setting for rendering and exporting RED 
QuickTime media. 
 

 
 

8. Click OK. 
 

Warning — Do not, under any circumstances, choose REDcode as the compressor for 
your sequence settings. All of the workflows described in this document rely upon the 
Sequence Settings using ProRes 422 as the compressor. 
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To quickly change a new sequence to support RED QuickTime media: 
1. Ingest a RED QuickTime clip into a Final Cut Pro project. 
2. Create a new sequence, open it, and edit the RED QuickTime clip into it. 
3. When a dialog asks you to “Change sequence settings to match the clip settings?” 

click Yes. 
Important — When you automatically adjust a sequence’s settings in this way, you still 
need to manually open the sequence settings and set the Video Processing tab to 
“Render 10-bit material in high-precision YUV” for the highest quality output. 

Real-Time Performance in Final Cut Pro Using RED QuickTime Media 
Because native RED media is extremely processor-intensive to work with, you’ll want to 
use Unlimited RT while you work. Otherwise, you may need to do a lot of rendering. 

Exporting Sequences Using RED Media from Final Cut Pro 
For the best quality when you export out of Final Cut Pro directly, set the Video 
Processing option in the Sequence Settings to “Render 10-bit material in high-precision 
YUV.”  

Remember, RED media is read-only; you cannot export media using the REDcode 
codec. When exporting a QuickTime file from a sequence using RED QuickTime media, 
it’s best to use either ProRes 422 (HQ) or Uncompressed 10-bit 4:2:2. 

Editing for Film Output from Color Using RED QuickTime Media 
Keep the following guidelines in mind when you’re editing a project that you want to 
grade in Color and output as DPX or Cineon image sequences to be printed to film:  

• Restrict transitions in your project to Cross Dissolves only. When you render DPX 
image sequences out of Color and use the Gather Rendered Media command to 
prepare a single image sequence for film printing, Color automatically processes all 
Cross Dissolves in your program. Other transitions are not supported, and will instead 
be processed as Cross Dissolves if they’re present in your project. 

• Keyframes are not sent from Final Cut Pro to Color, so don’t use the Motion tab to 
create animated pan and scan effects. Instead, use the Pan&Scan tab in the 
Geometry room of Color, which lets you scale, recenter, change the aspect ratio, and 
rotate your clips, and which can be keyframed. Pan&Scan effects are rendered along 
with your grades when you render DPX or Cineon image sequences out of Color. 

• Don’t use superimpositions, transfer modes, speed effects, filters, or multi-cam clips, 
unless you’re planning on prerendering these clips (exporting each as a self-contained 
QuickTime clip and reediting into the Timeline to replace the original effect) as ProRes 
422 or Uncompressed media before you send to Color. Color does not render these 
effects.
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Color Workflows Using RED Media 
This section covers the three supported postproduction workflows for using RED media 
when using Final Cut Pro and Color together. 

Workflow 1: Work and Finish Using ProRes 422 (HQ) 
This workflow describes transcoding your media from RED to 2K resolution ProRes 
clips, and then mastering using ProRes.  

• Advantage — This is a straightforward workflow with no reconforming necessary. 
Editing ProRes 422 media is fast and efficient. 

• Disadvantage — You lose the quality advantage of being able to grade and finish 
using the raw RGB 4:4:4 data that wrapped RED QuickTime files provide. Also, 
transcoding RED media to ProRes 422 can be time consuming. 
 

1. Transcode your archived RED media to ProRes 422 (HQ) using the Log and 
Transfer window. (For more information, see “Transcoding to ProRes 422.”) 

2. Edit, finish, and output using ProRes 422 (HQ) as you would any other project. 
 

Workflow 2: Work Offline Using ProRes;  
Finish Using RED QuickTime Media 
This workflow describes transcoding to ProRes for efficient offline editing, then 
reconforming your edited sequence to reingested RED QuickTime media for final 
mastering and color correction using Color.  

• Advantage — Editing with ProRes 422 media is less processor-intensive than editing 
using RED QuickTime files. After you reconform, you can work in Color at higher 
quality with access to all of the raw image data in the R3D file, as Color can bypass 
QuickTime and use the RED framework directly.  

• Disadvantage — Reconforming is an extra step that requires good organization. 
 

Stage 1 — Ingest Using ProRes, and Perform an Offline Edit 
1. If it’s necessary to edit your program at offline quality for efficiency, transcode the 

archived RED media to ProRes 422 or ProRes 422 (HQ) using the Log and Transfer 
window in Final Cut Pro. (For more information, see “Transcoding to ProRes 422.”) 

2. Edit your project in Final Cut Pro as you normally would. 
 

Stage 2 — Reconform Your Project to RED QuickTime Media 
1. Once your edit is locked, prepare your edited sequence to be media-managed by 

moving all video clips that aren’t being superimposed as part of a compositing 
operation down to track V1. This makes navigation and grade management much 
easier once you start working in Color, and may eliminate unused clips from the 
Timeline, reducing the amount of media needing to be reconformed. 
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2. If you haven’t already, create a “RED Using ProRes” sequence preset in Final Cut 
Pro. (For more information, see “Creating a RED Using ProRes Sequence Preset in 
Final Cut Pro.”) You’ll use this preset to media-manage your edited sequence. 

3. Right-click the edited sequence in the Browser, and choose Media Manage from the 
shortcut menu to open the Media Manager. The recommended settings are: 
• Media pop-up menu – Create Offline 
• Include render files – off 
• “Set sequences to” pop-up menu — “RED Using ProRes” (the name you gave the 

sequence preset you created) 
• Include master clips outside selection – off 
• Delete unused media from duplicated – off 
• Use Handles – off 
• Include affiliate clips outside selection – off 
• “Base media file names on” pop-up menu – existing file names 
• Duplicate selected items and place into a new project – on 
• Include nonactive multiclip angles – off 
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4. Next, click the Browse button in the Media Destination area and choose a location to 
save the media and the new offline sequence you’re creating, then click OK. 

5. When the Media Manager operation finishes, you need to change the ingest options 
of the Log and Transfer window before you begin to actually ingest media: 
5.1. Open the Log and Transfer window, and choose Preferences from the Action 

pop-up menu (the menu with the gear icon). 
5.2. When the Import Preferences sheet appears, choose Native from the 

“Transcode to” column corresponding to the RED Plugin. 
5.3. Close the Log and Transfer window when you’ve finished. 

6. Lastly, right-click the new offline sequence that’s been created, and choose Batch 
Capture from the shortcut menu. When the Log and Transfer window appears, 
reingest all necessary footage from your archived RED media directories. 
 

Stage 3 — Grade Your Program Using Color 
1. Prepare the sequence for sending to Color. Clips with effects or using media that is 

incompatible with Color (including clips with speed effects, still images, freeze 
frames, and multicam clips) should be prerendered as described in the “Moving 
Projects Between Final Cut Pro and Color” chapter of the Color User Manual. Export 
each clip that needs to be prerendered as either ProRes 422 (HQ) or Uncompressed 
10-bit 4:2:2, and edit the resulting .mov file into your Timeline to replace the original, 
unsupported clip. 

2. When you’re finished, right-click on your sequence in the Browser, and choose Send 
To > Color to send the prepared sequence to Color for grading.  
 
Once in Color, you’ll find that you have access to each clip’s camera setting 
metadata via the Red tab in the Primary In room. You can use the RED image data 
as is, or make adjustments as necessary. Please note, clips that have been 
transcoded to ProRes 422 (HQ) lose the ability to access these camera settings, as 
they no longer contain the native RED raw image data. 
 

Stage 4 — Render Out of Color 
1. When you’re ready to render the color-corrected project, you have two choices: 

• Option 1 – Render to DPX for film printing. As with the digital intermediate workflow 
described in the Color User Manual, Pan & Scan effects are rendered within Color 
when you select DPX or Cineon as your Render File Type, and dissolves are 
rendered by Color when you use the Gather Rendered Media command to 
assemble the final consecutively numbered image sequence for film output. 

• Option 2 – If you’re planning to output to SD or HD video (for example, if you’re 
rendering a second version of your program for video mastering), set the Render 
File Type to QuickTime, and set the QuickTime Export Codec to either ProRes 422 
(HQ) or Uncompressed 10-bit 4:2:2. After you’ve rendered the project, send it back 
to Final Cut Pro. 
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Workflow 3: Work and Finish Using REDcode 
This workflow consists of working in Final Cut Pro with transferred RED QuickTime clips 
from the very beginning, eliminating the reconform step completely.  

• Advantage —This is an efficient workflow that skips the need for reconforming, and 
gives you access to high-quality image data when you grade in Color. Ingesting RED 
QuickTime media is fast when compared to transcoding. This is a good workflow for 
projects such as short-form and spots. 

• Disadvantage — RED QuickTime media is processor-intensive when editing. 
 

1. Import all of your RED media using the Native option in the Log and Transfer 
window. (For more information, see “Ingesting RED QuickTime Files.”) 

2. While editing in Final Cut Pro, set your sequence to use the “RED using ProRes” 
sequence preset you created earlier. Also, for maximum responsiveness while you 
edit, set Final Cut Pro to use Unlimited RT. 

3. When you’re finished editing, send the sequence to Color, and then grade and 
output as described in “Stage 4: Render Out of Color” in the previous section. 
 

Use Unlimited RT When Editing RED QuickTime Media 
As mentioned previously, RED QuickTime media is processor-intensive to work with in 
Final Cut Pro. For the smoothest editing experience, choose Unlimited RT from the 
Timeline RT menu, set Playback Video Quality to Low or Medium, and set Playback 
Frame Rate to Full. 
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The RT pop-up menu in the upper-left corner of the Final Cut Pro Timeline lets you adjust 
playback quality in order to maximize real-time performance. 

Primary In Room Parameters for RED Media in Color 
When RED QuickTime media is sent to or imported into Color, a RED tab appears in the 
Primary In room, next to the Basic and Advanced tabs. There is no corresponding RED 
tab in the Primary Out room.  

 

The RED tab appears in the Primary In room whenever a RED QuickTime clip is selected as the 
current shot, and provides access to RED-specific parameters. 

The RED camera writes raw, linear light image data to the R3D files that are recorded. 
The controls found in the RED camera’s Audio/Video menus in no way alter the way the 
image data is written within each R3D file. Instead, whatever settings were chosen at 
the time are stored within each recorded clip as metadata (similar to a LUT) that 
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determines how these media files are displayed by compatible software. This metadata 
can be overridden during the Log and Transfer process. 

For clips that were imported with native color metadata, the RED tab provides access to 
the clip Color, Color Temp, and View metadata originally written by the RED camera. 
However, this metadata can also be overwritten during ingest using a custom color 
processing option in the Log and Transfer window. These parameters are provided so 
that you can begin grading each clip in the state at which it was originally monitored 
during the shoot, or at which it was ingested using the Log and Transfer window.  

Note — Although there is functional overlap between the controls found in this tab and 
those found elsewhere in Color, the Kelvin and Tint controls are specially calibrated to 
provide the most photometrically accurate white balance adjustments for RED 
QuickTime media. 

RED Image Controls 
The RED tab has the following parameters and controls: 

• Enabled — Turns all of the parameters found within the RED tab on or off. Turning 
Enabled off suspends the effect of these parameters on the final rendered image in 
Color. 

• Saturation — This parameter is available in the RED camera’s Color submenu, and 
adjusts the color intensity of the image. The overall range is 0 (monochome) through 
5.0 (extremely high), where 1 is unity. 

• Kelvin — This value is set by options in the RED camera’s Color Temp menu, along 
with Tint. This setting is designed to compensate for the “warmth” of the available 
lighting to keep white elements of the scene looking neutral. Low Kelvin values will 
compensate for “warmer” lighting (such as tungsten), while higher Kelvin values 
compensate for “cool” lighting (such as noon-day sun or overcast days). Two user-
selectable options set Kelvin to predetermined values: Tungsten (3,200K), and 
Daylight (5,600K). The Auto WB option automatically chooses a custom value for this 
parameter based on analysis of a white card, while Manual WB lets the operator 
choose any value. The correction made by this parameter is designed to work 
specifically with RED linear light image data to provide the most photometrically 
correct result. 

• Tint — This value is adjustable within the RED camera’s Color Temp menu, along 
with Kelvin. Tint is designed as an additional white balance compensation for light 
sources with a green or magenta component, such as fluorescent or sodium vapor 
bulbs. The correction made by this parameter is designed to work specifically with 
RED linear light image data to provide the most photometrically correct result. 

• Exposure — Available in the RED camera’s Color menu. Increases and lowers image 
lightness in increments calibrated to ƒ-stops. When raising the signal up to 100 or 
lowering it down to 0, the image is clipped at the boundaries of broadcast legality. The 
overall range is –7 to +7, where 0 is unity. 
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• Red, Green, and Blue Gain — Available in the RED camera’s Gain submenu. Allows 
individual adjustment of each color channel. Adjusting any of these gain parameters 
boosts or lowers the maximum value of the corresponding color channel, and scales 
the midtones while pinning the bottom of the channel to 0 percent. Lowering does the 
opposite. The overall range is 0 to 10, where 1 is unity. 

• Contrast — Available in the RED camera’s Color menu. Raising the contrast boosts 
the highlights and lowers the shadows, while leaving the midtones centered around 50 
percent unaffected. As the video signal reaches the boundaries of 100 and 0 percent, 
it’s compressed rather than clipped. The overall range is –1 to +1, where 0 is unity. 

• Brightness — Available in the RED camera’s Color menu. Raises and lowers image 
lightness. When raising the signal close to 100 or lowering it down to 0, the image is 
compressed rather then clipped. The overall range is –10 to +10, where 0 is unity. 

• Gamma pop-up menu — In-camera, the Gamma setting is determined by the Color 
Space option that’s selected in the RED Camera’s View menu (it’s not available as an 
individually adjustable parameter). There are six options for gamma available in Color. 

• Linear — No gamma adjustment is applied at all, linear-to-light as captured by the 
Mysterium sensor. 

• Rec. 709 — The standard gamma curve as specified by the Rec. 709 standard for 
video gamma. 

• REDspace – Similar to Rec. 709, but tweaked to be perceptually more appealing, 
with higher contrast and lighter midtones. 

• REDlog – A nonlinear, logarithmic gamma setting that maps the native 12-bit RED 
image data to a 10-bit curve. The blacks and midtones that occupy the lowest 8 
bits of the video signal maintain the same precision as in the original 12-bit data, 
while the highlights that occupy the highest 4 bits are compressed. While this 
reduces the precision of detail in the highlights, this is a relative loss as the linearly 
encoded data has an over-abundance of precision. 

• PDLOG 685 – Another logarithmic gamma setting that maps the native 12-bit RED 
image data into the linear portion of a Cineon or film transfer curve. 

• Color Space pop-up menu — These options are available in the RED Camera’s 
View menu (in-camera these options are tied to corresponding Gamma settings).  

• CameraRGB — Identified on the camera as RAW, this mode bypasses the RED 
camera matrix and represents the original, uncorrected sensor data. 

• REDspace — Fits the raw RED image data into a color space that’s larger than 
that of Rec. 709. Appropriate for digital cinema mastering and film output. 

• Rec. 709 — Fits the raw RED image data into the standard color space specified 
by the REC 709 standard for high definition video. Appropriate for HD video 
mastering. 

• ISO pop-up menu — A gain operation (similar to Exposure), which pins the black 
point at 0 while raising or lowering the white point of the image, linearly scaling 
everything in between. The range is 100–2000; 320 is the default unity gain setting (no 
change is made). Raising the signal too much can result in clipping. 
 
Important — Changing the ISO setting of your RED camera does not alter the 
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recorded data. However, since it changes the lightness of the image you’re monitoring 
during the shoot, it will influence how you light the scene and adjust the camera’s iris.  
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Using Proxies in Color 
When using RED QuickTime media in Color, you have the option of choosing a proxy 
setting in the User Preferences tab of the Setup room; otherwise, Color’s proxy 
mechanism is only available with DPX or Cineon image sequence-based projects.  

 

The Render, Grading, and Playback Proxy menus are found in the User Preferences tab of the 
Setup room of Color. 

The lower proxy setting of Quarter Resolution provides faster performance as you work 
in Color at the expense of slightly lower visual quality. Of course, this quality reduction is 
relative since you’re starting out with 2K media to begin with. 

Unlike DPX or Cineon-based proxies, there is no need to use the Generate Proxies 
command before changing the proxy resolution; all Grading and Playback proxies for 
RED QuickTime media are generated on the fly. 

Important — Whenever you work with proxies, it’s a good idea to review your grades at 
Full Resolution at least once before rendering your final output. 

 
Minimum and Maximum Levels for RED QuickTime Media 
In Color, RED QuickTime media is processed in its native RGB color space. This does 
not allow for processing values above absolute white (100 percent) or below absolute 
black (0 percent). As a result, all grades applied to RED media will clip beyond these 
outer boundaries, regardless of whether Broadcast Safe in Color is turned on or off.  

If Broadcast Safe is turned on, expanding the broadcast safe range by raising Ceiling 
IRE above 100 or lowering Floor IRE below 0 will have no affect on the image. However, 
restricting the broadcast safe range by lowering the Ceiling IRE below 100 or raising the 
Floor IRE above 0 will clip image values at the narrower limits. 

The default Printing Density for RED media is “Linear (0 Black - 1023 White).” This 
means that when rendering RED QuickTime media as DPX files for film printing, the 
minimum and maximum values of 0 and 100 percent in Color correspond to the digital 
values of 0 and 1023 in the rendered DPX files. The Printing Density setting for each 
shot is located in the Settings 2 tab to the right of the Timeline. 


